


Page 2 • BIOQUANT OSTEO 2015 Release Notes

BIOQUANT OSTEO 2015 Release Notes

Contents
BIOQUANT OSTEO: Osseointegration Update 4-20-2015

BIOQUANT OSTEO: Documentation

BIOQUANT OSTEO: New Feature: “Welcome” Screen

BIOQUANT OSTEO: New Feature: Measure Cells

BIOQUANT OSTEO: Enhancements: Chondrocyte Template & Protocol

BIOQUANT OSTEO: Enhancements: Multi-Selection Osteoid Type

BIOQUANT OSTEO: Enhancements: Threshold Region

BIOQUANT OSTEO: Enhancements: Tools List

BIOQUANT OSTEO: New Feature: Camera Presets

BIOQUANT OSTEO: No Longer Supported: Analog Camera

BIOQUANT OSTEO: Minor Enhancements

BIOQUANT Imaging Extensions: Enhancements

BIOQUANT SCAN: Enhancements

BIOQUANT Topographer: Enhancements



Page 3 • BIOQUANT OSTEO 2015 Release Notes

BIOQUANT OSTEO 2015, 15.1.6, 4-20-2015 UPDATE

The BIOQUANT OSTEO 2015, 15.1.6, version was originally released 1-31-2015. The following issue 
was found with one of the templates. An updated BIOQUANT OSTEO 2015, 15.1.6 version was re-
leased on 4-20-2015. This version contains all release note features in the original 1-31-2015 release 
plus the following change.

BIOQUANT OSTEO: Osseointegration Update 4-20-2015
The 4-20-2015 update to the BIOQUANT OSTEO 2015 software changed two calculations in the 
Osseointegration template to reference the correct primary data arrays. In the 1-31-2015 release, the 
primary data are accurate, however, the computed ratios were not.

OSSEOINTEGRATION TEMPLATE CALCULATIONS UPDATED

•	 P8 B.Ar/Sa.Ar (%)

New comment: P5/P4;%

•	 P9 Co.Pm/I.Pm (%)

New comment: P7/P2;%
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BIOQUANT OSTEO 2015, 15.1.6, 1-31-2015 RELEASE

BIOQUANT OSTEO: Documentation
The BIOQUANT OSTEO 2015 documentation has improved and is now available in multiple formats.

PDF MANUALS & HELP

•	 PDF Manuals are now automatically installed when BIOQUANT OSTEO 2015 is installed. 

•	 PDF Manuals can be opened directly from the desktop.

•	 The BIOQUANT OSTEO 2015 help system now opens the PDF Manual to the corresponding 
section when the help button, the ? button, or F1 is pressed.

EBOOK MANUALS

•	 The BIOQUANT OSTEO 2015 manuals are also available in the eBook format. Check the black 
installation folder that came with your BIOQUANT OSTEO 2015 DVD for instructions on 
installing the eBooks to your android tablet or iPad.

PROTOCOL VIDEO TUTORIALS

•	 Both the PDF and eBook Manuals now have expanded Video Tutorials integrated in the Protocol 
chapters.

BIOQUANT OSTEO: New Feature: “Welcome” Screen
When you double click the BIOQUANT OSTEO icon, the “Welcome to BIOQUANT! How would like to 
proceed?” splash screen now opens. This box offers several options for deciding which data volume 
and data set should be open in BIOQUANT.

On the Welcome to BIOQUANT screen, the Current Data Volume and Current Data Set is listed above 
the horizontal line on the Welcome screen. If no data set has been opened in the past or if this is the 
first time you’ve opened BIOQUANT, this region will be empty.
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WELCOME SCREEN

The new Welcome screen

FIRST TIME USERS

If this is the first time you have used BIOQUANT, we recommend that you open one of the OSTEO 
Sample data sets. For directions, see “Open a Different Data Set.”

OPEN CURRENT DATA SET

This option opens the data set indicated in the Current Data Volume and Current Data Set region, 
above the horizontal line. This option is greyed out if no data set is currently open in BIOQUANT.

Use this option to open the current data volume and current data set as indicated above the 
horizontal line.

CREATE A QUICK DATA SET

This button opens the Quick Data Set box. The Current Data Set listed above the horizontal line 
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is used as a template to create a new data set in the indicated Current Data Volume. This option is 
greyed out if no data set has ever been opened.

Use this option if you are continuing an existing project. The new data set will have the same guide, 
selected list, and calculation set assignments as the previous data set.

CREATE A NEW PROJECT

This button opens the Create New Data Set Wizard. The wizard then walks you through creating a 
new data set either in a new data volume or in the current data volume. 

Use this option if you are starting a new project. The data volume is often named after the project 
name and the data sets within are named after the animals or slides.

OPEN A DIFFERENT DATA SET

This button opens the Open Data Set dialog box. The box is then used to navigate the hard drive to 
open an existing data volume and data set.

FIRST TIME USERS

•	 Click the Open a Different Data Set button.

•	 In the Open Data Set box, in the Data Volumes list, choose -OSTEO 2015 Sample 
Volume-.

•	 Then, in the Data Sets list, choose the data set that best matches your project. If 
you don’t have a project yet, the Bone Basic Set data set is a good place to start.

•	 Click the Open button. The data sets opens.

BIOQUANT OSTEO: New Feature: Measure Cells
The new Measure Cells measurement type is used to quickly measure cells from field to field. This 
tool enables quick cell measurement by ensuring that only cells within the measurement area 
counted, automatically filtering out partial cell profiles cells cut by the region of interest, and 
preventing duplicate measurements on overlapping fields of view. The Measure Cells Type replaces 
Auto Exclusion and Edge Rejection from BIOQUANT OSTEO 2014.
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MEASURE CELLS

A new measurement type: Measure Cells

TOPIC CONTENTS

Supported Arrays

Pixel Scan

Reject All Edges

Quick Batch Script Button/List

Tools List

New, Preview, and Measure Buttons

SUPPORTED ARRAYS

The Measure Cells type requires a Primary Array, such as VC Area, and a Topo array. 

For Bone Morphometry we recommend using the VC Area array. Measure Cells has been integrated 
into the Chondrocyte Proliferation Protocol using the VC Area array. 

Other, less used arrays that are supported and may be useful for alternate protocols are Area, Density, 
Length, and Pixel Count.

PIXEL SCAN

The Pixel Scan number determines how many pixels to scan away from a thresholded object to search 
for a previously measured cell’s redraw tracing. This automatically prevents duplicate measurements 
across different fields of view.

In most cases, the default Pixel Scan value of 3 is adequate. If the object’s redraw from the previous 
field does not align well with the object on the current field, it may be that the previous redraw is not 
being associated with the object. In this case, increasing the Pixel Scan number causes the system to 
search farther away from the thresholded object for its redrawn measurement tracings.

•	 To change the Pixel Scan value, enter a number into the Pixel Scan box in the Measurement 
region (Measure Cells Type).
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PIXEL SCAN

To set Pixel Scan, enter a number into the box. The default value is 3.

REJECT ALL EDGES

The Reject All Edges checkbox is available for the Measure Cells measurement type. When activated, 
Edge Rejection ignores cells whose threshold touches the edge of the region of interest.

WHAT IS EDGE REJECTION?

•	 Edge Rejection filters out objects which touch the edge of the Region of Interest, so that 
partial objects are not included in the measurement.

•	 Edge Rejection works with all ROI types.

QUICK BATCH SCRIPT BUTTON/LIST

Quick Batch Script is a dual purpose button/list on the Measurement region (Measure Cells Type). It 
is used to run a batch script, open the Batch Measurement Editor box, or to see the recently used list.

TOOLS LIST

The Tools List contains tools that are used to filter objects from being Preview outlined or to modify 
a preview outline. All filters can be assigned to the current (highlighted) Selected array.

For more details on the features available in the Tools List, see “BIOQUANT OSTEO: Enhancements: 
Tools List.”

NEW, PREVIEW, AND MEASURE BUTTONS

When the Measurement type is set to Measure Cells, the “New”, “Preview”, and “Measure” buttons 
are visible along the bottom edge of the Measurement region. These buttons do the following:

•	 NEW: Begins a new cell measurement session. This button should be pressed once, on the first 
field of view to be measured.

The New button allows you to start a field to field measurement session at high power within 
the Tissue Volume created at low power. 

NEW BUTTON: ONLY PRESS ONCE

The New button should be pressed only once at the beginning of a field to field 
measurement session within the Tissue Volume. If you accidentally press New in the 
middle of a field to field measurement session, the system will no longer prevent 
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duplicate measurement with cells measured before the New button was clicked.

•	 PREVIEW: Generates preview outlines based on the current threshold and filter settings. No 
data is taken at this point; this is a preview only.

•	 MEASURE: Records the data from the preview outlines into the Selected array.

The preview tracings change to measurement tracings. The measurement tracings are usually 
assigned to a different color than the preview tracings.

BIOQUANT OSTEO: Enhancements: Chondrocyte Template 
& Protocol
The Chondrocyte Proliferation template and protocol have changed to use the new Measure Cells 
type to measure PCNA+ and PCNA- cells.

TEMPLATE CHANGES

•	 Rather than multiple Topo arrays, the template now has only one Topo array. 

•	 Ch.N+/Pr.Z.Ar has been renamed for Excel compatibility.

•	 The Measure Cells Measurement Type has been assigned to D4.

Previously, the General Measurement Type was used with Chondrocyte Proliferation.

PROTOCOL CHANGES

The Chondrocyte Protocol uses the new Measure Cells Measurement Type. The Measure Cells Type 
is used to quickly measure cells from field to field. This tool enables quick cell measurement by 
ensuring that only cells within the measurement area counted, automatically filtering out partial cell 
profiles cells cut by the region of interest, and preventing duplicate measurements on overlapping 
fields of view. 

CHONDROCYTE PROTOCOL

•	 Manual: The Chondrocyte Proliferation Protocol in the BIOQUANT OSTEO 2015 
Manual has been updated to use the Measure Cells Type. 

•	 Guide: The updated “Measure - Chondrocyte Proliferation” guide can be found 
under the “Other Bone Protocol Guides” heading.

BIOQUANT OSTEO: Enhancements: Multi-Selection 
Osteoid Type
The Osteoid measurement type has been enhanced so that multiple osteoid seams can be measured 
at a time. In addition, the Osteoid Measurement Type now automatically finds the ends of the osteoid 
seams. Also, the symbols used to represent parts of the osteoid measurements are now more visible.
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HUMAN OSTEOID EXAMPLE

The Osteoid Tool now has larger symbols.

SUMMARY OF NEW FEATURES

•	 The Osteoid Measurement Type now automatically finds the ends of the osteoid seam. You no 
longer have to click to define the end points.

MANUAL SET ENDS OVERRIDE

If the shape of the osteoid seam is not recognized by BIOQUANT so that the end 
points are not automatically recognized, you can still manually define the end points. 
A “Manual Set Ends” checkbox has been added to the Settings box of the Osteoid type, 
allowing you to return to the functionality of the previous version. When Manual Set 
Ends is checked, click the ends of a single osteoid seam, then click OK again to repeat 
for each other osteoid in the field of view.
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OSTEOID TOOL SETTINGS BOX

Manually Set Ends option has been added

•	 The Osteoid Measurement Type can now measure multiple osteoid seams simultaneously.

•	 The X symbols that mark the ends of the osteoid seam and the locations of the width 
measurements have been replaced with more visible boxes.

PROCEDURE

1.	 In the Selected List region, in the Selected list, click on D# to make Osteoid Volume the active 
array. Selecting the array retrieves any threshold and other parameters assigned to the array.

In the Tb.Rodent Templates, the default Osteoid Volume array is D13.

In the Tb.Human Templates, the default Osteoid Volume array is D8.

In custom templates, this may be a different array index.

2.	 If a threshold has not been assigned to the D# (OV) Osteoid Volume array, threshold the 
Osteoid.

3.	 Use the Editing tools to refine the osteoid threshold. The thresholded osteoid should have a 
relatively smooth surface. Also, the osteoid threshold should actually represent the surface.

EDITING POINTERS

•	 Preview will automatically fill the threshold, so don’t worry about filling each 
osteoid.

•	 Use Clean, Erode, and Dilate to remove miscellaneous trash in the image and 
smooth out the thresholded osteoid surface.

•	 Use Erase to separate osteoid from other thresholded objects, or use Draw to fill in 
cracks at the surface of the osteoid.

•	 If too much editing is involved, you can use the Draw tool to manually draw in the 
threshold instead.

4.	 In the Measurement region, from the Type list, choose Osteoid.
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OSTEOID TYPE

The Osteoid Measurement Type.

5.	 In the Measurement region (Osteoid Type), verify that the correct arrays are chosen:

If you do not want to collect one of the Osteoid measurements, choose N/A at the top of the 
drop list.

•	 Volume: In the Volume drop list, choose the VC Area array for Osteoid Volume.

Tb. Rodent templates default: D13 Osteoid Volume

Tb. Human templates default: D8 (OS) Osteoid Volume

•	 Width: In the Width drop list, choose the Individual Distance array for recording Osteoid 
Width. 

Tb. Rodent templates default: I1 Osteoid Width

Tb. Human templates default: I1 Osteoid Width

a.	 Surface: In the Surface drop list, choose the Length array for recording Osteoid Surface. 

Tb. Rodent templates default: L1 Osteoid Surface

Tb. Human templates default: L2 OS (Ob+) or L3 OS (Ob-)

6.	 In the Measurement region (Osteoid Type), next to the Type drop list, click the Assign button to 
assign the Volume, Width, and Surface arrays, as well as the Osteoid measurement type, to the 
D# (OV) Osteoid Volume array.

7.	 In the Measurement region (Osteoid Type), click Preview.

The cursor enters the Image window.

8.	 In the Image window, click once on each osteoid.

When the user clicks on an osteoid, any holes in the osteoid automatically fill with threshold. 

9.	 Right click to exit the Image Window.

The system preview outlines the osteoid, determines the osteoid surface side, and generates the 
widths.

EXAMINE THE IMAGE. THIS IS A PREVIEW MODE, NOTHING HAS BEEN RECORDED YET. 

•	 The two end points are indicated by yellow squares. 
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•	 The osteoid surface is indicated by the bright green squares.

•	 The osteoid width lines are bright green. 

RODENT OSTEOID EXAMPLE

The osteoid has been preview outlined.

10.	 If necessary, edit the Osteoid preview as follows:

INITIAL SETUP ONLY: ADJUST WIDTH INTERVAL OR ORIENTATION

•	 If the widths are too close or too far apart, click the Settings button and adjust the 
Interval value.

•	 If the width lines are not perpendicular, click the Settings button and increase the Factor 
value.

•	 Regenerate the widths to see the changes. Only adjust Interval or Factor setting at the 
beginning of a study.
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REVERSE OSTEOID SURFACE, IF NECESSARY
The osteoid surface is indicated by the bright green squares. If the Osteoid Surface indicated is 
on the wrong side of the osteoid, do the following:

a.	 In the Measurement region (Osteoid Type), click the Reverse button.

The cursor enters the Image window.

b.	 In the Image window, click on each osteoid that needs to have its surface reversed.

c.	 Right click to exit the Image window.

The Preview outlines update.

OSTEOID TYPE: REVERSE BUTTON

The Reverse button changes the side of the osteoid seam used to compute osteoid surface 
and find the perpendicular direction for width lines.

11.	 In the Measurement region (Osteoid Type), click the Measure button to save the Volume, Width, 
and Surface measurements to the designated arrays.

If you make a mistake, immediately choose “Undo Auto Object Measurement” from the Edit 
menu to revert the system to its state before the Save All Data button was clicked.

12.	 Repeat for all other fields of view in the Tissue Volume. 

Use Redraw to redraw any measured osteoid on overlapping fields of view to prevent duplicate 
measurement.

BIOQUANT OSTEO: Enhancements: Threshold Region
The Threshold region has been redesigned and contains new features.
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THRESHOLD REGION

New Threshold Region

TOPIC CONTENTS

Select and Add: Thresholding by Scroll Wheel

Disable Threshold

Threshold Transparency is Now Threshold Opacity

Threshold Range Bars Change

Zoom and Draw/Erase Threshold Enhancement

SELECT AND ADD: THRESHOLDING BY SCROLL WHEEL

The easiest way to define a threshold now is to use the scroll wheel when using Select and Add. Once 
the starting color has been chosen, scrolling the mouse wheel up adds similar colors automatically to 
the threshold. Scrolling the wheel down removes the least similar colors from the threshold. 

1.	 In the Threshold region of the ribbon, click Select. 

The cursor enters the Image window.

2.	 With the left mouse button, click a point on one of the objects of interest.

The pixel clicked and any other pixels in the Image Window that match the selected pixel’s red, 
green, and blue intensity values are highlighted.

3.	 Use one of the following methods to continue to add or remove the threshold.

NOTE: You can still tap the Z key to zoom. You can also still drag to create a selection box.

•	 Scroll the mouse wheel up to add threshold automatically. 

Scrolling the mouse wheel up adds similar colors automatically to the threshold. 

•	 Scroll the mouse wheel down to remove threshold automatically. 

Scrolling the wheel down removes the least similar colors from the threshold. 
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4.	 Click the right mouse button to exit the Image Window.

DISABLE THRESHOLD

The threshold can be disabled by clicking the Disable button so that it is DOWN to quickly turn off 
all three of the color channels. Clicking the Disable button so that it is UP will turn back on all three 
color channels.

When the stain is hard to threshold, disabling the threshold is useful because it allows the user to 
manually paint in the threshold using the Draw Threshold tool. Once the threshold is manually 
painted in, it can be automatically measured using the Measurement region.

THRESHOLD REGION

All three color channels have been disabled.

•	 To disable the red, green, and blue threshold color channels, click the Disable button so that it 
is DOWN.

When the Disable button is DOWN, all three of the color channel boxes become white.

ASSIGN NOTE

You can assign the disabled state of the three channels to the active array. Then, whenever you 
select that array in the future, the channels will deactivate. If you do so, however, you will need 
to assign a threshold for the next array in the Selected list that uses thresholding so that each 
threshold channel is turned ON.

•	 To enable the red, green, and blue threshold color channels, click the Disable button again so 
that it is UP.

Any threshold color channels that were OFF are turned back ON.

THRESHOLD TRANSPARENCY IS NOW THRESHOLD OPACITY

The Threshold Transparency drop list has been replaced with a Threshold Opacity drop list. This 
terminology is consistent with other imaging applications. The ability to adjust the opacity of the 
threshold has not changed.
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THRESHOLD REGION - OPACITY LIST

Use the Opacity drop list to choose a new opacity percentage.

THRESHOLD RANGE BARS CHANGE

Each color channel has a threshold range bar. A threshold range can be set by manually moving the 
range bars. This method, called dynamic thresholding, is usually reserved for those rare occasions 
when only one color channel is active. Attempting to threshold by moving the range bars on two or 
three active color channels can be confusing. For a better thresholding option, see “Select and Add: 
Thresholding by Scroll Wheel.”

1.	 Click the channel boxes for the two colors you would like to turn OFF so that they are not solid. 
Only one box should be ON, or solid.

2.	 Choose from the following:

•	 To adjust the upper limit of the threshold range: Imagine that the threshold bar is divided 
in half. Click toward the left edge of the threshold bar and drag left or right until the 
desired upper range is reached. You do not have to actually click on the colored range. 

In the Image window, pixels that have color values within the new range are 
highlighted.

•	 To adjust the lower limit of the threshold range: Imagine that the threshold bar is divided 
in half. Click toward the right edge of the threshold bar and drag left or right until the 
desired lower range is reached. You do not have to actually click on the colored range. 

In the Image window, pixels that have color values within the new range are 
highlighted.

The current RGB Threshold Range is displayed above the Threshold range bars. The 
ranges for channels which are off are also displayed.

ZOOM AND DRAW/ERASE THRESHOLD ENHANCEMENT

The Draw Threshold and Erase Threshold brush size circle now updates automatically when using the 
Z key to zoom in and out on the image.
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BIOQUANT OSTEO: Enhancements: Tools List
The Tools list in the Measurement region of the ribbon has several changes. The complete Tools 
list is only available with the General type and the Measure Cells type. A limited Tools list is also 
available for the Trace type. 

TOOLS LIST

New Tools List

TOPIC CONTENTS

Tools List Changes

Outline Editor Box

TOOLS LIST CHANGES

•	 The “Available Filters” list has been renamed “Tools.” 

•	 The Outline Type tools have been moved from the Editing region of the ribbon to the Outline 
Editor item in the Tools list.

OUTLINE EDITOR BOX

OUTLINE EDITOR BOX

Outline Editor has replaced the Outline Type in the Editing region.

The Outline Editor box can be opened by choosing the Outline Editor option under the Tools list in 
the Measurement region. The Outline Editor is available for the General, Measure Cells, and Trace 
Measurement Types.

The functionality matches the Outline Type in the Editing region of the ribbon from BIOQUANT 
OSTEO 2014.
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BIOQUANT OSTEO: New Feature: Camera Presets
Camera Presets have been added for supported QImaging digital cameras. Camera presets store 
exposure time, master gain, and white balance (red gain, green gain, and blue gain) values to a file in 
the Camera Presets folder on the hard drive. The camera preset file can be loaded later to retrieve the 
camera settings.

TOPIC CONTENTS

Save Camera Presets

Quickly Load A Camera Preset

Load the Default Fluorescence Camera Preset File

SAVE CAMERA PRESETS

Camera presets are saved using the Camera Setup dialog box.

CAMERA SETTINGS: SAVE PRESET

Click the Save Preset button in the lower right of the Camera Settings box

1.	 Adjust the camera settings as needed.

2.	 From the Image menu, choose Camera Setup.

The Camera Setup dialog box opens.

3.	 Click the Save Preset button.

The BQ Save File box opens. By default, camera preset files are stored in the Camera Presets 
folder inside the BIOQUANT OSTEO installation folder.

4.	 In the file name box, type a name for the preset file.
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5.	 Click the Save button.

QUICKLY LOAD A CAMERA PRESET

Camera presets can be loaded from either the Camera Setup dialog box or by clicking the Load 
Camera Preset button in the Image region, Live Image type.

1.	 In the Image region, change the Type drop list to Live Image.

2.	 Click the [...] button to the right of the Live / Held button. This is the load camera presets 
button.

The BQ Open File dialog box opens. By default, the box opens to the Camera Presets folder in 
the BIOQUANT OSTEO installation folder.

IMAGE REGION (LIVE IMAGE TYPE)

Notice the new [...] button to the right of Live/Held. This is the load camera presets button.

3.	 In the BQ Open File box, choose the intended camera presets file, then click the Open button.

The live image changes to reflect the new camera settings.

LOAD CAMERA PRESET FOR EDITING

If changes must be made to a camera preset, open the preset from the Camera Setup dialog box, edit 
the file, and re-save it.

1.	 From the Image menu, choose Camera Setup.

The Camera Setup dialog box opens.

2.	 Click the Load Preset button.

The BQ Open File box opens. By default camera preset files are stored in the Camera Presets 
folder inside the BIOQUANT OSTEO installation folder.

3.	 Click the preset file to be edited and click the Open button.



Page 21 • BIOQUANT OSTEO 2015 Release Notes

4.	 After the camera settings have been edited, save the preset file again.

LOAD THE DEFAULT FLUORESCENCE CAMERA PRESET FILE

BIOQUANT provides a default fluorescence camera preset file that sets the exposure time to 100ms 
and the gain to 5. This is the longest exposure time that creates a live image that is still easy to focus.

1.	 Using a low power lens, such as 4x, set up the microscope for brightfield viewing.

2.	 Once the specimen is in focus, turn off the brightfield light and turn on the fluorescent light.

3.	 Switch to the lens that will be used for fluorescent imaging.

4.	 In the Imaging region, click the [...] button next to the Live/Held button to open the Load 
Camera Presets box.

5.	 On Load Camera Presets, click the “Fluorescence.cps” preset file then click the Open button.

6.	 Examine the image in the Image window.

POINTERS

•	 To adjust the brightness of the image, adjust the output of the excitation source.

•	 If the excitation source is not adjustable then the gain setting in BIOQUANT can be 
adjusted instead using the Camera Setup box.

BIOQUANT OSTEO: No Longer Supported: Analog Camera
The BIOQUANT OSTEO 2015 version no longer supports analog cameras. As more and more features 
for very high resolution images are added, this backward compatibly support has become too hard to 
maintain. If you have an analog camera and would like to receive a quotation to upgrade to a digital 
camera, contact sales.

MENU ITEMS REMOVED

•	 On the Image menu, “Open Analog Camera” has been removed.

•	 On the Image menu, “Close Analog Camera” has been removed.
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BIOQUANT OSTEO: Minor Enhancements
TOPIC CONTENTS

Image Window Now Contains Full Image File Path

Large Image Navigator: Fine Move Set Now Remembered

ROI Enhancements: Topo ROI Right Click Enhancement

Editing Region Redesign

dLS Type: Larger Width Symbols

Batch Editor: New Commands

Reset Parameters Expanded

IMAGE WINDOW NOW CONTAINS FULL IMAGE FILE PATH

The full path name of the currently open image is displayed on the title bar of the Image window and 
remains there until updated by loading a new image.

LARGE IMAGE NAVIGATOR: FINE MOVE SET NOW REMEMBERED

On the Large Image Navigator’s Navigator Setup box, the Fine Move Step value is now remembered 
across sessions. The Coarse Move Step value was already remembered in BIOQUANT OSTEO 2014.

NAVIGATOR SETUP

Fine Move Step (% of Pan Box) is now remembered across sessions of BIOQUANT.

PSEUDOCOLOR: NEW OUTPUT TABLES

BIOQUANT OSTEO 2015 includes two pseudocolor output table files. These files can be opened in the 
Pseudocolor box to set the color palette to predefined values. 

LOADING AN OUTPUT TABLE

•	 To open an output table, on the Pseudocolor box, from the File menu, choose Load 
Output Tables. 

•	 In the Open box, double click the desired .pal file.
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•	  Spectrum.pal

This palette is constructed of the colors in the visible light spectrum. 

PSEUDOCOLOR BOX

Spectrum.pal

•	 BlackBody.pal

This palette is constructed from the color of radiation emitted by blackbody objects at different 
temperatures.

PSEUDOCOLOR BOX

BlackBody.pal

ROI ENHANCEMENTS: TOPO ROI RIGHT CLICK ENHANCEMENT

When using the Topo ROI Type in the ROI Tools region, if the user right clicks to cancel before 
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clicking in the Image window to choose the Topo tracing, the prior ROI is redrawn.

EDITING REGION REDESIGN

NEW EDITING REGION

Text has been added to the buttons, as well a new tool: Cut Edges

•	 The Type drop list has been removed, all the tools in the Editing region are now related to 
editing the threshold. The Outline Type has been moved to the Measurement region under 
Tools as the Outline Editor item. See “Outline Editor Box.”

•	 Text has been added to all the buttons to make their functions more obvious.

•	 The new Cut Edges tool has been added. Cut Edges removes all the threshold objects that touch 
the edges of the region of interest.

•	 The zoom level for threshold editing automatically resets to 1:1 when you right click to exit the 
Image window.

DLS TYPE: LARGER WIDTH SYMBOLS

The X symbols that mark the locations of the inter-label width measurements have been replaced 
with more visible boxes.
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DLS TYPE

The symbols indicating the inter-label width measurements are more prominent.

BATCH EDITOR: NEW COMMANDS

The following commands have been added to Batch Measurement. To add the new commands, on the 
Batch Editor box, click the Add button. Then, on the Add Steps box, double click the command in the 
list. 

•	 The “Disable Preview After Edit” command has been added. 

This checks the “Disable Preview After Edit” box on the Editing Setup box accessed by clicking 
Setup in the Editing region of the ribbon. 

Disable Preview After Edit allows a series of automated threshold editing steps to be processed 
faster since there is no need to wait for the preview tracing to update after each one.

•	 The “Enable Preview After Edit” command has been added.

This enables the “Enable Preview After Edit” box on the Editing Setup box accessed by clicking 
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Setup in the Editing region of the ribbon.

Enable Preview after Edit will allow preview outlines to be generated after most Editing 
commands.

•	 A “Measure Cells New” command has been added to complement the new Measure Cells type.

This is the same as clicking the New button on the Measure Cells Measurement Type.

•	 A “Measure Cells Preview” command has been added to complement the new Measure Cells 
type.

This is the same as clicking the Preview button on the Measure Cells Measurement Type.

•	 A “Measure Cells Measure” command has been added to complement the Measure Cells type.

This is the same as clicking the Measure button on the Measure Cells Measurement Type.

RESET PARAMETERS EXPANDED

Reset parameters has been updated to match the expanded set of assignments. When you click Reset 
Parameters, the system is reset to default parameters. Make sure you click the Selected array again 
after clicking Reset Parameters to retrieve any array assignments. 

RESET PARAMETER ACTIONS

•	 Additive Mode: OFF

•	 Subtractive Mode: OFF

•	 Save to Topo Array: ON

•	 Comment Memory Recall: ON

•	 Update Display by Comment: ON

•	 Extend to Live Image: OFF

•	 Live Manual Measure: OFF

•	 Live Redraw All: ON

•	 Navigator Updates Redraw: ON

•	 Show Landmark: ON

•	 Mark Object: OFF

•	 Label Object: OFF

•	 Sound: OFF

•	 Save Window Positions: OFF

•	 Threshold Opacity: 50%

•	 Show Threshold: ON

•	 Outline Filter Smoothing: 2

•	 Outline Filter Low Filter: 15
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•	 Outline Filter High Filter 65535

•	 Void Filter Smoothing: 2

•	 Void Filter Low Filter 15

•	 Void Filter High Filter 1500

•	 Measurement Filters: OFF

•	 Live/Held Image: Held

•	 Background Correction: OFF

•	 Stereology Grid: Cleared.

BIOQUANT Imaging Extensions: Enhancements
TOPIC CONTENTS

microCT Navigator Enhancements

Very Large Images

MICROCT NAVIGATOR ENHANCEMENTS 

•	 Orientation reference graphics have been added to the microCT navigator to show the plane of 
section and the rotation of the data.

MICROCT NAVIGATOR - Z VIEW

Note the orientation reference graphic above the Level and Window sliders.
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•	 DICOM image handling has improved for images with the Smallest Image Pixel Value and 
Largest Image Pixel Value flags.

VERY LARGE IMAGES

•	 BIF files can now be saved as uncompressed TIF files up to 4GB.

•	 TIF files up to 4GB can be saved as BIF images.

•	 The Large Image Navigator can now open uncompressed TIF files up to 4GB from sources such 
as Aperio ImageScope and Photoshop CC, as long as the computer has enough memory.

BIOQUANT SCAN: Enhancements
TOPIC CONTENTS

Manual Focus Enhancements

Photobleach Protection

Software Control of the PhotoFluor II

OSTEOIMAGER Software Control Enhancements

MANUAL FOCUS ENHANCEMENTS

BIOQUANT SCAN supports scanning with pauses for a technician to periodically adjust the focus of 
the section. A few improvements have been made to this process.

•	 A “Back” button has been added.

When the stage pauses to allow for refocusing, clicking the back button moves the stage to 
preceding image capture positions. This is helpful if the stage is set to only stop every 3 fields of 
view to adjust focus. The stage can be backed up to the 1st or 2nd field to adjust the focus and 
recapture the images. Clicking the Continue button resumes automated image capture.

•	 The system waits before going to the next slide.

When BIOQUANT SCAN is set up to scan multiple slides in one pass, the system will pause 
on the last field of view for each slide. This gives the technician a chance to use the new Back 
button and recapture the last few images if needed. Clicking the Continue button resumes 
automated image capture.

PHOTOBLEACH PROTECTION

When scanning a large fluorescent section, the technician may not always be on hand to swap the 
slides when the scan is finished. To avoid photobleaching the section, two new features have been 
added.
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AUTOMATICALLY CLOSE THE PHOTOFLUOR II EXCITATION SHUTTER
The PhotoFluor II is a fluorescence excitation source from 89 North. It has a serial port interface 
to the computer which allows BIOQUANT OSTEO to control the shutter remotely.

SCAN MULTIPLE SLIDES SETUP BOX

The PhotoFluor Shutter Control checkbox appears at the bottom right 
 of the Scan Multiple Slides Setup box.

a.	 Begin a scan multiple slide project.

b.	 On Scan Multiple Slides, set the various scan areas for the samples.

c.	 In the Photobleach Safe Stop region, check the “Auto Close / Open Shutter” check box.

d.	 Begin the scan.

After the sections are scanned, BIOQUANT SCAN will close the shutter on the PhotoFluor 
II excitation source. This helps keep the sample from fading.

MOVE TO A BLANK LOCATION ON THE SLIDE
For microscopes without a PhotoFluor II excitation source, the next best option to protect the 
sample is to move it out of the light path.
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SCAN MULTIPLE SLIDES SETUP BOX

The Photobleach Safe Stop option appears at the bottom right of the Scan Multiple Slides

a.	 Begin a scan multiple slide project.

b.	 On Scan Multiple Slides, set the various scan areas for the samples.

c.	 Move the stage to a blank location on the last slide scanned.

d.	 In the Photobleach Safe Stop region, click the Set button.

e.	 Begin the scan.

After the sections are scanned, BIOQUANT SCAN moves the sample to the marked blank 
part of the slide. This helps keep the sample from fading.

SOFTWARE CONTROL OF THE PHOTOFLUOR II

BIOQUANT now supports software control of the 89 North PhotoFluor II illuminator. The Scan 
menu can now adjust the brightness of the PhotoFluor II as well as open and close its shutter. The 
PhotoFluor II can be controlled both by the software and by its front button panel.

SETTING UP THE HARDWARE

a.	 Connect the USB to COM port adapter provided with the PhotoFluor II to the BIOQUANT 
computer.

This is adapter is needed because most modern computers have only one serial COM port. 
This port is normally used by the motorized stage controller. The drivers for the USB to 
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COM port adapter are part of Windows.

b.	 In the device manager, configure the USB to COM port driver to use the COM2 port.

Contact BIOQUANT technical services at 615-350-7866 or at support@bioquant.com with 
questions.

c.	 Connect the PhotoFluor II to the USB adapter using the serial cable provided with the 
PhotoFluor II.

d.	 Contact technical services to get the BIOQUANT driver needed enable this feature in 
BIOQUANT OSTEO.

SETTING THE UV EXCITATION LEVEL

•	 On the Scan menu, choose the excitation throughput needed. Available settings are: Set 
UV Excitation 20%, Set UV Excitation 40%, Set UV Excitation 60%, Set UV Excitation 75%, 
Set UV Excitation 100%

CONTROLLING THE EXCITATION SHUTTER

•	 On the Scan menu choose “Open Excitation Shutter” or “Close Excitation Shutter”.

OSTEOIMAGER SOFTWARE CONTROL ENHANCEMENTS

A few minor improvement have been made to software control of the OSTEOIMAGER.

•	 In the Parameters region, the Mag drop list now controls the OSTEOIMAGER nosepiece to 
automatically choose the matching objective lens.

•	 On the Scan menu, the Turn Light On menu item has been renamed to “Turn Transmitted Light 
On” to avoid confusion with the new excitation source controls.

•	 On the Scan menu, the Turn Light Off menu item has been renamed to “Turn Transmitted Light 
Off” to avoid confusion with the new excitation source controls.

BIOQUANT Topographer: Enhancements
TOPIC CONTENTS

Selected Arrays Box Changes

Open Data Set Change

SELECTED ARRAYS BOX CHANGES

•	 Save and Load Selected Lists now work.
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•	 The menu items “Increment Element: Current Array” and “Increment Element: All Arrays” have 
been removed.

OPEN DATA SET CHANGE

•	 Changing the data set in the BIOQUANT Topographer now has no impact on the open data 
set in BIOQUANT OSTEO. When you return to BIOQUANT OSTEO from the Topographer, the 
original data set that was open in OSTEO is still open.
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